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INTRODUCTION

INTRODUCTION
About NIOSH

NIOSH is the acronym for the National Institute for Occupational
Safety and Health, a Federal agency established by the
Occupational Safety and Health Act of 1970. NIOSH is part of the
Centers for Disease Control and Prevention (CDC) and is
responsible for conducting research and making recommendations
for preventing work-related illnesses and injuries. The Institute’s
responsibilities include the following:

« Investigating potentially hazardous working conditions as
requested by employers or employees

« Evaluating workplace hazards ranging from chemicals to
machinery

* Creating and disseminating methods for preventing disease,
injury, and disability

¢ Conducting research and providing scientifically valid
recommendations for protecting workers

NIOSH CD-ROMs

NIOSH issues CD-ROMs to provide, in a single source, collections
of Institute documents. The CD-ROM format can store large
amounts of information, which is then readily available to workers,
employers, occupational safety and health professionals,
organizations and government agencies, and other interested
parties. In addition, the ability to electronically search the complete
contents of the CD-ROMs for a particular subject(s) or concept(s)
enhances the usefulness of this product.

A description of the type(s) of NIOSH documents on each CD-
ROM is contained in the insert that accompanies the CD-ROM.
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This information is also available on the CD-ROM itself (see
“Document Set Info,” page 31).

The CD-ROMs are created by linking the electronic text of each
page to an actual image of that page. A printed copy of each of the
documents is scanned using optical character recognition (OCR) to
create an electronic text of that document before creating the link.

When searching the CD-ROMs, you are actually searching the
electronic text. Because OCR conversion is not 100% accurate, the
scanning process may introduce some errors into the electronic text
(see “What is Pundit?” on page 6). Therefore, only the actual page
images are the official versions of the documents.

The software used to search the NIOSH CD-ROMs is a Windows-
based program called Pundit*, which is contained on the CD-ROM
discs. Detailed instructions for installing Pundit on your computer
and searching the CD-ROM s are contained in this User’s Guide.

Pundit contains a variety of features that facilitate your use of the
CD-ROMs. For example, a list of all the documents on each disc
can be automatically generated using the Browse option (page 36).
The fuzzy search capability (page 15) and the Vocabulary option
(page 35) can be used to overcome some of the errors introduced
by the OCR scanning. The electronic text of the documents can be
downloaded into word processing software using the Launch
option (page 32). Pundit’s features are described in detail in the
following pages.

*Pundit was developed by HGO Technology, Inc., under a contract with NIOSH. Pundit
was written using development software from ZyCO International, portions copyright©
1996 ZyCO International. Pundit may not be duplicated. Windows® is a registered
trademark of Microsoft Corporation, Redmond, WA.
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WELCOME TO PUNDIT

Installing Pundit on Your Computer

System Requirements

Pundit can run on any computer that supports Microsoft Windows
version 3.1, 3.11, or Windows 95. However, performance will be
noticeably slow on anything less than a 386DX 33MHz system
with a 2X CD-ROM drive. Approximately 5 megabytes of free
hard drive space are needed to install Pundit. A mouse is
recommended but not required.

If you want to print document text or images, you also need a
Windows-compatible printer that is configured and set up for your
system. Printing images requires a graphics-capable printer with
2MB of memory.

Microsoft Windows 3.1 or 3.11

Pundit can be installed from any single-disc NIOSH CD-ROM;
from a multi-disc set, it will only install from Disc 1. To install
Pundit:

Insert the single disc (or Disc 1) in your CD-ROM drive.
From Windows Program Manager, choose File.

From the File pull-down menu, choose Run.

In the Command Line text box, type D:setup

and press ENTER.

Note: This assumes that your CD-ROM is configured as
drive D. If it is configured as a different drive, type the drive
letter for your CD-ROM drive instead of D.

¢ Follow the set-up instructions on your screen.
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The installation process creates a program group and icon for
Pundit. To run Pundit, simply double-click on its icon.

Microsoft Windows 95
To install Pundit on a computer running Microsoft Windows 95:

¢ Insert the CD in your CD-ROM drive.

¢ From the main Windows 95 screen, choose Start.

¢ From the Start menu, choose Run.

¢ In the Open text box, type D:setup and press ENTER.
Note: This assumes that your CD-ROM is configured as
drive D. If it is configured as a different drive, type the drive
letter for your CD-ROM drive instead of D. '

» Follow the set up instructions on your screen.
The installation process creates a program folder and icon for

Pundit in the Start menu. To run Pundit, simply double-click on its
icon.
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Pundit Files

The installation program copies the following files to your hard
drive:

In the\WINDOWS\SYSTEM directory:

CMDIALOG.VBX  MSMASKED.VBX THREED.VBX
COMPOBJ.DLL NWCONN.DLL VBDB300.DLL

EMEDIT2.VBX NWCORE.DLL VBOA300.DLL
GAUGE.VBX NWMISC.DLL VBRUN300.DLL
HAPLDLL NWWRKSTN.DLL VER.DLL
LEAD.VBX OLE2.DLL ZYBANYAN.DLL
LEADA45.DLL OUTLUIL.DLL ZYDDD.DLL
LEADDIB.DRV SPIN.VBX ZYNOVELL.DLL

LEADRUN.VBX STORAGE.DLL ZYOLE.DLL

In the \WINDOWS directory:

PUNDIT.INI

All other files are copied to the \PUNDIT directory.

Note: Some of the files Pundit installs are common “shared”
Windows files and may already be installed on your system by
other programs. Pundit’s installation program only copies a file if
Pundit can supply a more recent version than the existing one.

If you ever remove Pundit from your system, be careful when
deleting the above files. If you remove shared files, other
programs that use them may be unable to run.
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What Is Pundit?

Pundit is a Microsoft Windows software program designed to
search and retrieve electronically stored documents. These
documents were digitized by a scanner and are stored on CD-ROM
in two formats: the scanned images of the pages and text
transcriptions of the images.

Each document has a single file that contains the transcription of
the text and several associated images—one for each page. The
digitized images contain pictures of text, not actual text. Pundit
searches the text transcriptions, not the picture. These
transcriptions were produced by processing the scanned image of
each document through an optical character recognition (OCR)
program that “reads” the digital images and translates them into a
text format.

Although OCR is a highly advanced technology, it is not 100%
accurate, and some words may be erroneously transcribed.
However, each page of text is linked internally to its corresponding
digital image, and Pundit allows you to access both the text and its
related image. Since these images are photocopies of the originals,
you can compare the image to the electronic text file to uncover
any transcription €rrors.

Pundit also allows you to manipulate the digitized images of a
document in several ways, including resizing, zooming, rotating,
and inverting. In addition, Pundit allows you to print either the text
transcription or the digitized images of any document.

Because document images and text are stored on CD-ROM, you
cannot edit them or save any changes to the CD-ROM. However, a
Pundit feature allows you to “launch” a document into any other
associated application, such as Windows Write or Notepad. From
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these other applications, you can edit and save text copies of
documents.

Pundit has been developed using standard modern software
conventions, in particular those used by Microsoft Windows. As a
result, experienced Windows users should find it very easy to
navigate in Pundit and may wish to skip to “A Quick Tour of
Pundit” (pages 9-10) for an overview. That summary can then
serve as a reference. Those not as familiar with Windows may wish
to read the entire Pundit User’s Guide.

Conventions Used in This Guide

This Pundit User’s Guide assumes that you will be using a mouse
and that you know how to access Windows menus and buttons
with a mouse. For more detailed information on using a mouse, or
for information on Windows in general, consult the Microsoft
Windows User’s Guide.

If you do not have a mouse or if you prefer to use the keyboard, all
of Pundit’s functions have keyboard equivalents. They are
provided for you in the appendices to this guide.

Mouse users may wish to refer to Appendix D (“Pundit Hot Keys,”
page 50) for information on Pundit’s shortcut keystroke
equivalents.

Certain typeface conventions are used throughout this guide:
 File names, directories, path names, and drives are
capitalized:
MYFILETXT C:\MYDIRWMYFILE.TXT
* Keyboard keys are in small caps:
ESC TAB CTRL ENTER
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» Instructions to hold down one key while depressing a
second key are indicated by a plus sign:

ALT+F  CTRL+TAB
 Instructions to press two keys sequentially but not
simultaneously are indicated by a comma:
TAB, DOWN ARROW
» The two previous notations are sometimes combined:
ALT+F, P

In this example you would press and hold down ALT while
pressing F. Release the first two keys, then press P.

* Names of on-screen buttons are in boldface:
OK Cancel

¢ Text that you type in or enter is in bold italic:
D>setup

This Pundit User’s Guide contains “screen captures” (graphic
reproductions) of many of Pundit’s windows and dialog boxes.
These screen captures represent the way Pundit looks in Windows
3.1 and 3.11. If you are running Pundit in Windows 95, the
windows and dialog boxes will appear somewhat differently on
your screen. However, all menu, button, and control names are the
same.
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A QUICK TOUR OF PUNDIT

If you are an experienced Windows user, the easiest way to learn
about Pundit is to run it yourself and experiment. Later, when you
want to know more about individual features, you can use Pundit’s
on-line help facility or this guide. To get you started as quickly as
possible, the following section provides a brief overview of
Pundit’s most basic features.

There are five windows in Pundit: the main Pundit window, and
four secondary windows—Enter a Search, Search Results, Text
Viewer, and Image Viewer.

The Pundit Window

The Pundit window is the main program window, and it holds all
the other Pundit windows. The menu bar is accessible from every
other window except the Image Viewer, which has its own menu
bar. The availability of items in the Pundit window’s menu bar
depends on the currently open window. When an item is
inaccessible, it appears dimmed or grey.

The Enter a Search Window

This window is where you begin to search for a word or phrase in a
document. This window is open by default each time you start
Pundit. From this window you can

« Enter a search string or select one from a list

¢ Specify the search criteria, including “progressive’ and
“fuzzy” searches, wild cards, and the inclusion of Boolean
and quorum operators (see pages 12-16)

* Begin a search
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The Search Results Window

This window displays the results of a document search. From here
you can

Open Pundit’s Text Viewer to view a document

Print the Search Results list

Save the Search Results list as a text file

Launch a document into another Windows application

Return to the Enter a Search window

The Text Viewer Window

This window displays the text of a document. From here you can

Open the previous or next document in the Search Results
list

Move to the previous or next “hit” (match to the search
term) in the document

Perform a word search in the document

Print the current document or a specified range of pages
Save the current document as a text file

Open the Image Viewer to view the image corresponding to
the current document page

Return to the Search Results and Enter a Search windows

The Image Viewer Window

The Image Viewer displays the actual digitalized images associated
with a document. From here you can

Move to the first, last, previous, or next image of the
document

Manipulate the image attributes (resizing, zooming,
rotating, inverting)

Open a picture within an image

Print the image

Return to the Text Viewer

10
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THE ENTER A SEARCH WINDOW

This 1s where you begin a typical Pundit session. The window is
open by default when you start Pundit. To begin a search:

 Insert the word or phrase you want to search for by

— Clicking on the Search Statement text box and entering the

search string,
OR

— Copying text from the Vocabulary list (see “Vocabulary,”
page 35) to the Search Statement box by highlighting the
word or phrase, then selecting Insert (or highlight and then
double-click).

o Select Search or press ENTER.

Pundit |+ ]
File Edit Find Results Options ‘YWindow Help

Enter a Search

The Enter a Search Window

11
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Should you want to search more than one Pundit disc for the same
search statement:

Highlight the search statement.

Press CTRL+C to copy it.

Return to the Pundit window.

- Open the File pull-down menu.

- Choose the Select New Index option.

- Click on OK to have Pundit initialize a new index
(see page 29).

Remove the CD and insert the new disc in the drive.

Be sure the cursor is in the Search Statement box.

Press SHIFT+INSERT to “paste” the statement in the box.

Continue with the search procedures.

This procedure may be used whether the Pundit discs are from the
same or different sets.

Pundit provides a variety of search capabilities:

You can use a search string that is either a single word or a

phrase:

health retrieves all documents that contain
the word health

surgeon general retrieves all documents that contain
the phrase Surgeon General

You can use the Boolean operators AND, OR, and NOT to
establish relationships between terms:

niosh OR cdc retrieves all documents that contain

either term

12
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fire AND NOT resistant retrieves all documents that include
the first term but not the second

You can establish an order of precedence using parentheses:

accident AND (car OR automobile)
retrieves all documents that include
both accident and car and all
documents that include both accident
and automobile

You can use wild cards to make a search string more flexible:
? replaces a single character
* replaces multiple characters

Both the ? and the * can be used in any position within a
search string.

Note: Searches using wild cards result in longer search times
and larger Search Results lists.

a?id retrieves all documents that include
acid, avid, arid, or amid

lab* retrieves all documents that include
lab, laboratory, or labor

Note: Use this feature judiciously, since it will list all
documents in which the string appears as part of any and ALL
words, such as label and labyrinth.

13
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* You can use W/ and P/ to perform proximity searches, which
retrieve documents that contain one word within a certain
proximity of another:

fires W/S laboratory retrieves all documents in which
fires occurs within five words of
laboratory

fires P/4 laboratory retrieves all documents in which
fires precedes laboratory by no more
than four words

* You can also use the P operator without a stated range:

fires P laboratory retrieves all documents in which
fires occurs preceding laboratory,
regardless of their distance from
each other

* You can also specify proximity within specified ranges:

carbon monoxide /-5,3/ exhaust
retrieves all documents in which
carbon monoxide precedes exhaust
by no more than five words or
follows exhaust by no more than
three words

Note: In order for this to work, the slashes must be set apart
Jfrom the words by at least one space.

14
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The arithmetic operators < (less than), <= (less than or equal
to), = (equal to), <> (not equal to), > (greater than), and >=
(greater than or equal to) can also be used in a search:

welding AND >= 1975 retrieves all documents in which
both the word welding and a date or
number greater than /974 appear

You can use a quorum operator to search for a number of terms
from one to all:

contaminants AND 2 of {air, water, laboratory}
retrieves all documents in which
contaminants appears with air and
water, or with air and laboratory, or
with water and laboratory

You can use the separators EOD (end of document), EOP (end
of paragraph), and EOG (end of page) to mark a physically
defined portion of a document:

alerts to EOP {fires} retrieves all documents in which
fires follows alerts within the same
paragraph

Progressive and Fuzzy Searches

If the Progressive and Fuzzy check boxes are available in the Enter
a Search window, you can use them to specify how a search is
conducted. See “Progressive & Fuzzy,” page 42.

15
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If the Progressive box is checked, searches are performed only on
the documents from the immediately preceding search instead of
on the entire collection. In this way, you can continually narrow
down the list of documents until you find the one you want.

If the Fuzzy box is checked, the criterion for a search is changed to
include words that are close in spelling to the specified search
string. This option can help you find words or phrases that may
have been erroneously transcribed by the OCR process.

You can specify the degree of closeness by setting Degree next to
the Fuzzy check box. The range is 1 to 4—the higher the degree,
the greater the tolerance of error allowed in a search:

what with a degree of 1 would retrieve that, whit,
chat

what with a degree of 2 would retrieve seat, shot,
chit, when

what with a degree of 3 would retrieve many words,
all with only a single letter in
common with the search
string

Typically, we recommend a setting no higher than 2—higher
settings increase search time and produce extraneous hits.

Note: Use fuzzy searches only when you are having trouble finding
your search term or suspect that you are not finding all
occurrences. Fuzzy searches have long search times and produce
lengthy Search Results lists.

16
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THE SEARCH RESULTS WINDOW

Once a search has been successfully completed, the results appear
in a list box in the Search Results window. The results list contains
all documents that satisfy the search statement criteria. Each
document name is preceded by the number of times (“hits”) the
search statement word or phrase appears in that document. The
results list may be sorted alphabetically by document name or
numerically by the number of hits (see “Sort Order,” page 40).

Select the document that you want to view or launch by moving
the highlighting in the list box using UP ARROW, DOWN ARROW, Or
single-clicking on it with the mouse.

Note: Double-clicking on a document in the results list box
automatically opens it into the Text Viewer.

: Pundit
File Edit Find Results Qptions Window Help

Search Results - sulfur dioxide

Arsenic. Inorganic (Revised)., 1975
Arsenic, Inorgamnic, 1974
Asbestos, 1972

Asphalt Fumes, 1977

Carbon Dioxide, 1976

Chlorine, 1976

Coal Gasification Plants, 1978
Coke Oven Emissions. 1973
Confined Spaces. Vorking in. 1979
Cotton Dust, 1974

Ethylene Dibromide, 1977
Fluorides, Inorganic. 1975
Formaldehyde. 13976

Hydrazines, 1978

Hydrogen Fluoride, 1976

Hydrogen Sulfide, 1977
Hydroquinones. 1978

Malathion, 1976

Mercury, Inorganic, 1973

Nickel. Inorganic, 1977

Nitric Acid, 1976

Nitrogen. Oxides of., 1976
Pesticides, Nanufacture and Foraulation of, 1978

LU

e B R RS R RS e R e i R RS RS

The Search Results Window

17
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The Search Results ToolBar

The Search Results Window has its own ToolBar that allows you
to access its functions with a single mouse click instead of using
the pull-down menus. The following table contains brief
descriptions of the functions of the ToolBar buttons. It also
provides references to the sections in this guide that have more
detailed information about the function.

Search Results ToolBar l

F Button
Search

Action

Returns you to the Enter a Search window
See The Enter a Search Window—page 11

Opens the selected document in Text Viewer

View See The Text Viewer Window—page 19
Print Prints the Search Results list _
i See Print—page 33
Exports the selected document to the associated
Launch | Windows application

See Launc, e 32

18
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THE TEXT VIEWER WINDOW

Once you select a document for viewing, it is displayed in the Text
Viewer window. You can move through the document by using the
scroll bar to the right of the document window or by using PAGE
UP, PAGE DOWN, UP ARROW, or DOWN ARROW.

Often a document is too wide to fit within the window, and its right
edge appears truncated. You can move sideways in such a
document by using the horizontal scroll bar across the bottom of
the window. Alternatively, you can position the mouse pointer in
the document and hold down the left button while you drag the
mouse horizontally across the document in the window.

The text displayed in the Text Viewer window is the electronic
transcription of the scanned images. Because the OCR process is
not 100% accurate, errors and omissions may exist in the electronic
text. Therefore, only the image pages are the official versions of
the documents.

Elle Edit Find Results OQptions YWindow Help

3 Text Viewer - Coal Mine Dust, Respirable, 1995

In the Federal Mine Safety and Health Act of 1977 (Public Law 95-164) and the Occupational
Safety and Health Act of 1970 (Public Law 91-596), Congress declared that its purpose was to
assure, msofar as possible, safe and healthful working conditions for every working man and
bvoman and to presarve our human rasources. In these Acts, the National Institute for Occupa-
honal Safety and Health (NIOSH) 15 charged with recommendmng occupational safety and health
ktandards and describmg exposure levels that are safe for various penods of employment,
including but not linuited to the exposures at which no worker will suffer dimmished health,
Junctional capacity, or life expectancy as a result of his or her work experience, By means of
lcriteria documents, NIOSH communicates these recommended standards to regulatory agencies
mcluding the Occupahonal Safety and Health Adminustr ation [OSHA| and the Mine Safety and
Health Administration [MSHA|) and to others m the community of occupatonal safety and

health.

[Criteria documents provide the scientific basis for new occupational safety and health standards
[These documents generally contain a critical review of the scientific and technical mformation
lavailable on the prevalence of hazards, the existence of safety and health risks, and the adequacy
jof control methods. In addition to transmiting these documents to the Department of Labor,

L Ty

The Text Viewer Window

19
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The Text Viewer ToolBar

The Text Viewer window has its own ToolBar that allows you to
access its functions with a single mouse click instead of using the
pull-down menus. The following table contains brief descriptions
of the functions of the ToolBar buttons. It also provides references
to the sections in this guide that have more detailed information on
the function.

Text Viewer ToolBar
Button Action
Sk Returns you to the Enter a Search window
See The Enter a Search Window—page 11
Result Returns you to the Search Results window
See The Search Results Window—page 17
<<Doc Opens previous document in Search Results list
See Previous Document—page 38
<<Hit Moves to the previous hit in the current document
See Previous Hit—page 37
Hit>> Moves to the next hit in the current document
See Next Hit—page 37
Doc>> Opens the next document in Search Results list
See Next Document—page 38
2 Prints the current document or selected pages
Print i
See Print—page 33
Exports the selected document to the associated
Launch Windows application
See Launch—page 32
Opens the image associated with the current
Image document
See The Image Viewer Window—page 21

20
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THE IMAGE VIEWER WINDOW

Once an image is opened for viewing, it appears in the Image
Viewer window. Note the following Image Viewer constraints:

* You can open only one image at a time.

* You cannot minimize the Image Viewer window.

* You cannot move the Image Viewer to the background.

* You cannot access any controls in any other open Pundit
windows (even if you can see them on your screen).

* You must close the Image Viewer if you want to access any
outside functions.

If the image you have selected is too large to fit within the Image
Viewer window, only part of it is displayed. You can view the rest
of the image by using the Image Viewer scroll bars or by using the
various options available from the Image Viewer pull-down
menus: File, View, Effects, Browse, and Pictures.

These functions are discussed in detail in the sections that follow.

= Close - Close Image Viewer
File View Effects Browse

N(QSH - JULY 1988

The Image Viewer ToolBar
(The descriptions on the next page are
in the same order as are the tools on the toolbar.)
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The Image Viewer ToolBar

Most of the Image Viewer’s menu options are available on this
convenient horizontal toolbar just below the menu bar on the
Image Viewer window. It enables you to execute the options with a
single mouse click.

As you TAB to each icon, the title bar of the window changes to
describe the icon function. The following table briefly describes
the Image Viewer ToolBar functions. For a more detailed
description of each tool’s function, see the pages referenced.

Image Viewer ToolBar I

Tool Action & Reference
Info Provides information about the displayed image
See Image Info—page 23
Close Closes the image; returns to the text document
See Close—page 24
. Prints the current image
Print See Print—page 23
Invert Reverses black/white image to white/black, and back
See Invert—page 25
Fit Resizes the image to fit in the window
See Fit Image—page 24
Reset Restores initial image size, proportions
See Reset Image—page 24
Zooms in
Zn See Zoom—page 24
Zooms out
Z-Out See Zoom—page 24
Left Rotates the image 90° counterclockwise
See Rotate—page 25
Right Rotates the image 90° clockwise
See Rotate—page 25
First Opens the image of the document’s first page
See First Page—page 26
Last Opens the image of the document’s last page
See Last Page—page 26
Prev Opens the image of the document’s previous page
See Previous Page—page 26
Next Opens the image of the document’s next page
See Next Page—page 26 |
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The Image Viewer File Menu

Open the menu by clicking on File on the menu bar (or press
ALT+F). Click on the option you want to select. The File pull-down
menu offers four options: Image Info, Print, Print Setup, and Close.
Unless otherwise noted, you can also access the options from the
Image Viewer ToolBar.

Image Info

This option allows you to view specific information about the
current image (height, width, compression type, etc.).

When you select this option, a message box appears displaying
information about the current image.

To close Image Info, select Close from the Image Information box.

Print

This option allows you to print the open image on your currently
active printer, provided it is a graphics-capable printer with at least
2MB of memory.

Print Setup

This option allows you to configure the printer used for printing
Pundit images.

This option can be accessed only from the File pull-down menu.

When you select this option, the Print Setup dialog box appears.
From this box you can set the many options available for
configuring your printer. Some of these options may not be
applicable to Pundit or to your particular system and are therefore
inaccessible; these display as dimmed or grey. For further

information about configuring your printer, consult the Microsoft
Windows User'’s Guide.
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Close

This option closes the open image and returns you to the document

in the Text Viewer window at the same place you were when you
entered the Image Viewer.

The Image Viewer View Menu

Open the menu by clicking on View on the menu bar (or press
ALT+V). Click on the option you want to select. The View pull-
down menu offers four options: Reset Image, Fit Image, Zoom,
and Rotate. Unless otherwise noted, you can also access these
options from the Image Viewer ToolBar.

Reset Image

This option restores the image to its original attributes, undoing
any changes you may have made to it.

Fit Image
This option resizes the image to fit completely within the Image
Viewer window.

Select Reset Image to restore the image to its original size.

Zoom

This option allows you to alter the size of the image being
displayed: In enlarges the image by about 15%. Out reduces the
image by about 15%. When an image reaches its maximum or
minimum extremes, the Zoom In/Out functions produce no further
effect.

Both operations can be performed several times in succession.
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Select Reset Image to restore the image to its original size.

You can also zoom in on a portion of an image. Define the area
you want to enlarge by depressing the left mouse button and
dragging it diagonally across the document image. A rectangle will
temporarily appear to indicate the defined area. Release the left
mouse button and the selected area enlarges to fill the Image
Viewer window. Once an image reaches its maximum zoom
extreme, trying to zoom in with the mouse has no effect.

Rotate

This option allows you to turn the image counterclockwise or
clockwise in increments of 90 degrees.

Choose Right (90 Degrees) to rotate the image clockwise; Left
(90 Degrees) to rotate the image counterclockwise.

You can rotate an image any number of times in succession.

Use Reset Image to restore an image to its original orientation.

The Image Viewer Effects Menu

Open the menu by clicking on Effects from the menu bar (or press
ALT+F). The Effects pull-down menu offers a single option—
Invert, which is also available from the Image Viewer ToolBar.

Invert

This option changes the image’s display attributes from black-on-
white to white-on-black, giving a “photographic negative” effect.

Use the Reset option or the Invert option to restore the image’s
original attributes.
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The Image Viewer Browse Menu

Open the menu by clicking on Browse on the menu bar (or press
ALT+B). Click on the option you want to select. The Browse pull-
down menu offers four options: Previous Page, Next Page, First
Page, and Last Page. Unless otherwise noted, you can also access
these options from the Image Viewer ToolBar.

Previous Page

This option opens the image associated with the previous page of
the current document. A message box informs you if there is no
previous page.

Next Page

This option opens the image associated with the next page of the
current document. A message box informs you if there is no next
page.

First Page

This option opens the image associated with the first page of the
current document. If the first page is already displayed, there is no
change.

Last Page

This option opens the image associated with the last page of the
current document. If the last page is already displayed, there is no
change.
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The Image Viewer Pictures Menu

If a document contains photographs, as you are viewing the image
files of the text an indicator will let you know there are photos on
the page you are viewing. The Pictures options allow you to view
and manipulate the photographs. The Pictures pull-down menu
offers four options: First Picture, Next Picture, Previous Picture,
and Page Image. Open the menu by clicking on Pictures from the
menu bar (or press ALT+P). Click on the option you want to select.

Note: The Pictures pull-down menu appears only if the opened
image has one or more separate photographs associated with it.

First Picture

The First Picture option opens the first photograph within the
document image into the Image Viewer window. Once open, you
can manipulate the photograph in all the ways you can manipulate
the document’s image: by resizing, zooming, rotating, and
inverting. Options that are not accessible appear dimmed or grey
on the pull-down menus and on the Image Viewer ToolBar.

Next Picture

If a photograph is open in the Image Viewer window, the Next
Picture option closes the open photograph, then opens the next one.
Once open, you can manipulate the photograph in all the ways you
can manipulate the document’s image: by resizing, zooming,
rotating, and inverting. If there is no next photograph, a message
box is displayed.

Previous Picture

If a photograph is open in the Image Viewer window, the Previous
Picture option closes the open photograph, then opens the previous
one. Once open, you can manipulate the photograph in all the ways
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you can manipulate the document’s image: by resizing, zooming,
rotating, and inverting. Options that are inaccessible appear
dimmed or grey in the pull-down menus and on the Image Viewer
ToolBar. If there is no previous photograph, a message box is
displayed.

Page Image

If a photograph is open in the Image Viewer window, the Page
Image option closes the photograph and returns you to the
document’s image.
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THE PUNDIT WINDOW

The Pundit window is the main window of the program. All other
Pundit windows are contained inside this window. The items in the
menu bar across the top are accessible from all other Pundit
windows except the Image Viewer, which has its own menu bar.
The availability of each menu item depends on the currently open
window. When a menu item is unavailable, it appears dimmed or

grey.

The File Menu

You can access this pull-down menu from the main Pundit window
by choosing File from the main menu bar. The pull-down menu
offers eight options: Select New Index, Document Set Info,

Save As, Launch, View Page Image, Print, Print Setup, and Exit.

Select New Index

This option enables you to insert different Pundit discs that contain
different document sets, without exiting the application. These
discs may be from the same multi-disc set or from a different set of
documents entirely.

When you select this option, a dialog box displays providing you
with instructions for proceeding. The current drive is displayed in
the Available Drives box. You can open the list of drives to select
another CD drive.

You must not change discs until instructed to do so. This allows
Pundit to close out the index list of documents before opening
another. If you remove a disc too soon, or select an empty CD
drive, or insert the wrong disc, Pundit advises you of the error and
provides instructions for continuing.
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Select New Index

Select a drive that contains a vaid PUNDIT disc |
from the list of drives below.

s 1w ot o e =

Press <Cancel> to abort this operation.

Available Drives:
[cDle:

The Select New Index Box

In all cases, a prompt appears reminding you that the search
information or criteria you have entered to that point will be
erased. You can Cancel to return to the disc in use, or OK to
change discs and have Pundit initialize a new index.

Should you want to search more than one Pundit disc using the
same search statement, follow these steps instead:

» Highlight the search statement.
* Press CONTR+C to copy it.

* Return to the Pundit window and select new index as
described previously.

When the new disc is in place, return to the Search Statement box
and

* Press SHIFT+INSERT to “paste” the statement in the box.
* Continue with the search procedures.

This, too, may be used whether the Pundit discs are from the same
or different sets.
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Document Set Info

This option provides you with the following information:

Document Set Name— the name of the collection(s) of
documents on the active disc.

Document Set Description—a brief explanation of the
contents of the disc. This description duplicates the material
contained in the insert that accompanies the CD-ROM. It
provides information about the type(s) of documents on the
disc, including applicability and limitations.

Save As

This option is available only when either the Search Results or
Text Viewer window is open.

From the Search Results window, you can save a Search Results
list as an ASCII text file.

From the Text Viewer window, you can save the complete open
document (or any highlighted portion of it) as an ASCII text file.

In the open Save As dialog box, type a file name in the File
Name text entry box.

You can change the drive and/or path in which you want
the file saved, either by using the Drives and Directories

boxes or by entering a drive and/or path in the File Name
text entry box.

When you are ready to save the file, choose OK. If you
have entered an existing file name, a message box offers
you the option of replacing the existing file or canceling the
save so you can change the file name.

31



THE PUNDIT WINDOW

Launch

Use this option to open a text document into another Windows
application. The application that launches the document is
determined by the application that your copy of Windows currently
associates with .TXT files. For example, if .TXT files are currently
associated with Write, Launch opens the current text document into
Write.

To associate files in Windows 3.1 or 3.11, use the Associate option
on the File menu in the Windows File Manager. For more
information on associating files, see the Microsoft Windows User’s
Guide.

Launch is available only when the Search Results window is open.
To use Launch:

¢ Select a document from the Search Results list.
¢ Select Launch.

You can also activate Launch from the Search Results ToolBar.

View Page Image

This option opens the Image Viewer window so you can view the
actual scanned image associated with a text document. The View
Page option is available only when the Text Viewer window is

open.

Several images are usually associated with one document. The
image that opens for viewing is the one associated with the page
currently displayed in the Text Viewer window.

You can also select Image from the Text Viewer ToolBar.
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For additional information about using the Image Viewer, see “The
Image Viewer Window,” page 21.

Print

The Print option allows you to print a Search Results list, the text
of an entire document, or any number of text pages of a document,
depending on which Pundit window is open. These will print on
your currently active printer. You cannot print an image using the
main Pundit window’s Print option. To print an image, you must
use the Image Viewer’s Print option. See “Print,” page 23.

e To print the Search Results list from the Search Results
window, choose File from the main Pundit menu, then
select Print. You can also select Print from the Search
Results ToolBar.

» To print the entire text document or a specified number of
pages from the Text Viewer window, choose File from the
main Pundit menu. Then select Print to open the Print
dialog box.

e Choose All to print the entire document, or choose Pages to
print a selection of pages. If you select Pages, you must
specify the range of page numbers in the From and To text
boxes.

You can also select Print from the Text Viewer ToolBar.

Print Setup
This option enables you to configure the printer used for printing in
Pundit.

From this dialog box you can set the many options available for
configuring your printer. Some of these options may not be
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applicable to Pundit or to your particular system and are therefore
inaccessible. Options that are inaccessible appear dimmed or grey.
For further information about configuring your printer, consult the
Microsoft Windows User’s Guide.

Exit

This option allows you to leave the Pundit System and return to
Microsoft Windows. To access this option:

¢ From the main Pundit window, choose File.

» Select Exit to open a message box.

¢ Choose Cancel to return to Pundit or OK to exit to
Microsoft Windows.

The Edit Menu

The Edit pull-down menu offers a single option—Copy. Open the
menu from the main Pundit window by clicking on Edit from the
menu bar (or press ALT+E). Then click on Copy.

Copy

Use this option to copy a portion of text onto the Windows
Clipboard so you can paste it into another Windows application.
You can only copy when the Text Viewer window is open.

o Highlight a portion of text in the Text Viewer window.
¢ From the main Pundit window, choose Edit, then select
Copy. You can also accomplish this by pressing CTRL+C.

The highlighted text is now copied onto the Windows Clipboard.
You can open another Windows application and insert the copied
text with that application’s Paste option.
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The Find Menu

The Find pull-down menu offers six options: Enter a Search,
Search History, Vocabulary, Browse, Quick Help, and Word
Search. Open the menu from the main Pundit window by clicking
on Find from the menu bar (or press ALT+F). Click on the option
you want to select.

Enter a Search

This option allows you to reopen the Enter a Search window and
begin a search. When Pundit is first started, the Enter a Search
window is automatically opened for you.

Search History

This option allows you to view your previous search strings in the
Enter a Search window along with the number of hits and number
of documents found.

You can also select the Search History button in the Enter a
Search window.

Vocabulary

This option allows you to display the contents of the search index
in the Enter a Search window. The search index is the list of words
that Pundit uses to match against the search statement. The index is
a list of all words in all the documents and was compiled from the
electronic text of the scanned documents on the active disc.
Because of the errors inherent in the OCR process, the index
contains partial words or words with incorrect characters. The
index appears only in the Enter a Search window. The default
display starts at the first real word.
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You can also select the Vocabulary button in the Enter a Search
window.

You can select words from the vocabulary list as search terms by
highlighting the word or phrase, then selecting Insert (or highlight
and then double-click).

Browse

This option allows you to view a list of all documents on the
CD-ROM. The Browse option is available only when the Enter a
Search window is open.

You can also select the Browse button in the Enter a Search
window.

Quick Help

This option displays a quick help reference on creating search
strings in Pundit in the Enter a Search window.

You can also press CTRL+Q or select the Quick Help button in the
Enter a Search window.

Word Search

This option allows you to search forward from the cursor position
for a specific word (or string of characters within a word) in the
document you are viewing.

When you select this menu item, a dialog box displays. You can
then

» Enter the word or character string to search for (the search
is not case-sensitive).
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e Check if you want the search to be performed ONLY on the
whole word (or else the search will find all words that
include the specified character string).

The Results Menu

Open the menu from the main Pundit window by clicking on
Results from the menu bar (or press ALT+R). Click on the option
you want to select. The Results pull-down menu offers four
options: Previous Hit, Next Hit, Previous Document, and Next
Document.

Previous Hit

This option allows you to move to the previous place in the
document where Pundit found a match to your search string. It
displays and highlights the line of the document where the
previous match to your search string occurs. The Previous Hit
option is available only when the Text Viewer window is open. If
there is no previous match in the document, a message box is
displayed.

You can also select <<Hit from the Text Viewer ToolBar.

Next Hit

This option allows you to move to the next place in the document
where Pundit found a match to your search string. It displays and
highlights the line of the document where the next match to your
search string occurs. The Next Hit option is available only when
the Text Viewer window is open.

If there are no more matches in the document, a message box is
displayed.

You can also select Hit>> from the Text Viewer ToolBar.
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Previous Document

This option allows you to move to the previous document in the
compiled search list. The Previous Document option is available
only when the Text Viewer window is open.

The currently opened document is closed, and the previous
document in the list is opened. If there is no previous document in
the search, the current document remains open and a message box
is displayed.

You can also select <<Doc from the Text Viewer ToolBar.

Next Document

This option allows you to move to the next document in the
compiled search list. The Next Document option is available only
when the Text Viewer window is open.

The option closes the currently open document and opens the next
document in the list. If there is no next document in the list, the
current document remains open and a message box is displayed.

You can also select Doc>> from the Text Viewer ToolBar.

The Options Menu

The Options pull-down menu offers four options: Results Format,
Display Format, Progressive & Fuzzy, and Save Preferences. Open
the menu from the main Pundit window by clicking on Options
from the menu bar (or press ALT+0). Click on the option you want
to select.
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Results Format

This option allows you to configure the information displayed in
the Search Results window. This option is not available when the
Search Results window is open.

In the Results Format Options dialog box, select the options you
want displayed in the Search Results window; then choose OK.

|~ Results Format Options

elect deswed tems that will be shown in the Seaich
esults display window.

™ Column Information:
& Hits!

OFilename @ 0ny O Path/Filename

X Document Name

[~ Footer Information:
[J Document Name X Search
[ path X Prompt

The Results Format Options Dialog Box
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Column Information

The options are Hits, Filename, and Document Name. Select
the options you want displayed in the Search Results window.
If you select Filename, you also have the option of specifying
either Filename Only or Path and Filename.

Footer Information

The options are Document Name, Path, Search, and Prompt.
Select the options you want displayed in the Search Results
footer.

Sort Order

Opens the Results Sort Order dialog box, allowing you to
specify the order of the Search Results list.

i T

® Dasumeni Nas)
|

O Number of Hits

=
@ Ascending
O Descending

The Results Sort Order
Dialog Box

Sort Key

Choose either Document Name or Number of Hits to
specify how Pundit sorts the Search Results list.
Document names are sorted alphabetically; hits are
sorted numerically.

Direction
Choose either Ascending or Descending to specify the
order of the Search Results list.
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Display Format

This option allows you to configure the information displayed in
the Text Viewer window. This option is not available when the
Text Viewer window is open.

In the Display Format Options dialog box, select the options you
want displayed in the Text Viewer window; then choose OK.

Display Format Options

[ Show In Header:
B (Butions!

Show In Footer:

<] Document Name -
B

™ Document Name || [X] Search

@ Document Name
O Path & Name

& Search & Prompt -
" Viewed Document Dptions:
Show In Title Bar: Cursor Starts At:

O Start of Document
@ First Hit

The Display Format Options Dialog Box
Show in Header

The options are Buttons, Document Name, and Search. Select
the options you want displayed in the Text Viewer header.

Show in Footer

The options are Document Name, Search, and Prompt. Select
the options you want displayed in the Text Viewer footer.

Font

Opens a dialog box that allows you to select the font used in
the Text Viewer.
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Show in Title Bar

Choose either Document Name or Path & Name for display in
the Text Viewer’s Title Bar.

Cursor Starts At
Choose either Start of Document or First Hit to determine

where the cursor is positioned when a document is first opened
in the Text Viewer.

Progressive & Fuzzy

This option allows you to toggle on or off the availability of the
Progressive and Fuzzy check boxes in the Enter a Search window.
The default is for the check boxes to be available.

Once the Progressive and Fuzzy check boxes are available, you can
use them to specify how a search is conducted. See examples in
“Progressive and Fuzzy Searches,” page 15.

* From the main Pundit window, choose Options.

o From the Options pull-down menu, choose Progressive &
Fuzzy.

» The Progressive and Fuzzy check boxes appear in the
bottom third of the Search window.

Save Preferences

This option enables you to save or retain the changes you have
made to the Pundit configuration. If you choose not to invoke this
option or if you forget to select it, Pundit will appear as it did
before you made changes the next time you enter it. To Save
Preferences, open the menu and click on the option.
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The Window Menu

The Window pull-down menu offers a single option—Cascade.
Open the menu from the main Pundit window by clicking on
Window from the menu bar (or press ALT+W). Click on Cascade.

Cascade

When more than one window is open, you can use the Cascade
option to arrange the windows. Cascaded windows overlap so that
the title bar of each is visible.

The Help Menu

The Help pull-down menu offers four options: Contents, Search for
Help On, How to Use Help, and About Pundit. Open the menu
from the main Pundit window by clicking on Help from the menu
bar (or press ALT+H). Click on the option you select.

You can also access the help system from anywhere in Pundit by
pressing F1. This key provides context-sensitive help, which means
that the help screen that appears when you press F1 is determined
by your current location within the program. Since you cannot
access the main Pundit window’s menu bar from the Image Viewer
window, you must use the F1 key to access on-line help when the
Image Viewer is open.

Contents
This option displays a list of all available on-line help topics.

Search for Help On

This option allows you to search the help system for information
about a topic that you specify.
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Select a topic, then choose Go To.

THE IMAGE HANDLER WINDOW File: Printer Setup
THE PUNDIT WINDOW File: Print
THE PUNDIT WINDOW File: Print Setup

The Help Search Dialog Box

 In the text entry box that appears, type in the word on
which you would like help, or choose one from the
accompanying scrollable list.

¢ When the word you want is displayed in the text box,
choose Show Topics.

o A list of topics appears in the lower box list. Select a topic,
then choose Go To.

e A window appears with information about your chosen
topic.

For further information about searching for help, or for information
about using the Windows Help system in general, consult the
Microsoft Windows User’s Guide.

How to Use Help

This option displays instructions for using the Windows on-line
help features.

About Pundit

This option displays information about the development and
capabilities of the Pundit software.
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APPENDICES

Appendix A
Using the Keyboard in Pundit

Although getting around Pundit is easiest with a mouse, all of
Pundit’s functions are available with keystroke equivalents.
Choosing a menu item, a window button, or a control with the
keyboard instead of the mouse is simple. All of the menu bar items
and many of the window controls have mnemonics (underlined
letters). To activate a pull-down menu, hold down ALT and then
press the mnemonic. Then use UP ARROW or DOWN ARROW to move
the highlighting to the desired menu option and press ENTER.
Alternatively, you could choose a menu option by pressing ALT

and the menu mnemonic and then pressing the menu item
mnemonic.

Edit Find Results Options Window Help

Launch Ctrl+L
View Page Image F9
Print... Cul+P
Print Setup...

Exit

Sample Pull-down Menu

To select a button or control with the keyboard, you need to move
the “focus” of the program to the control you want. To move the
focus in a window, use the TAB key. A control that has the focus
will appear highlighted in some fashion. Sometimes it will appear
darker; sometimes it will have a dotted outline. Once the control

45



APPENDICES

you want has the focus, you can proceed. If the control is a button,
pressing ENTER will activate it. If it is text box, you can begin

entering text. If it is a check box, you can check it by using SPACE
BAR.

If you need further information about using the keyboard in
Windows, consult the Microsoft Windows User’s Guide.
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Appendix B

Pundit Keyboard Equivalents

The following table lists the functions in Pundit and the keys to
access them. For more detailed information about the functions,
see the pages referenced in this User’s Guide.

|| Main Pundit Window Keyboard Equivalents
Menu Function Keys Reference
|hu-: Save As ALTHF, A Page 31
“ Launch ALT+F, L Page 32
View Page ALT+F, V Page 32
Print ALT+F, P Page 33
Print Setup ALT+F, S Page 33
Exit ALT+F, X Page 34
EDIT Copy ALT+E, C Page 34
I FiND Enter a Search ALT+1, E Page 35
Search History ALT+L S Page 35
Vocabulary ALTHL, V Page 35
Browse ALTH, B Page 36
Quick Help ALTHL, Q Page 36
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Appendix B (continued)

|| Main Pundit Window Keyboard Equivalents “
Menu Function Keys Reference !l
RESULTS | Previous Hit ALTHR, P Page 37
Next Hit ALTH+R,N Page 37
Previous
+
Dot ALT+R, D Page 38
Next
+
' Document ALTH+R, X Page 38
|| OPTIONS | Results Format ALT+O, R Page 39
Display
" Forgist ALT+O,D Page 41
Progressive &
F ALT+O, P Page 42
Save
Prifsriicaa ALT+O, V Page 42
WINDOW | Cascade ALT+W, C Page 43
HELP | Contents ALT+H, C Page 43
Search For
+
Help On ALT+H, S Page 43 |
How to Use
Help ALT+H, H Page 44 I
i About Pundit ALT+H, B Page 44 I
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Appendix C
Image Viewer Keyboard Equivalents

The following table lists the Image Viewer hot keys along with their
functions and a reference within this guide.

Image Viewer Keyboard Equivalents
Menu Function Keys Reference
FILE Image Info ALT+HF, I Page 23
Print ALT+F, P Page 23
Print Setup ALT+F, S Page 23
Close ALT+F, C Page 24
VIEW Reset Image ALT+V, S Page 24
Fit Image ALT+V,F Page 24
Zoom ALT+V, Z, 1 Page 24
ALT+V, Z, O
Rotate ALT+V,R,L Page 25
ALT+V,R,R
EFFECTS | Invert ALTHE, I Page 25
BROWSE | Previous Page ALT+B, P Page 26
Next Page ALT+B, N Page 26
First Page ALT+B, F Page 26
Last Page ALT+B, L Page 26
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Appendix D
Pundit Hot Keys

Certain functions in Pundit can be accessed with key combinations
commonly known as hot keys. These hot keys are often more convenient
to use than the pull-down menu equivalents. Menu items with their
equivalent hot key combinations are listed in the pull-down menu to the
right of the menu item. The following table lists the Pundit hot keys
along with their functions and a reference within this guide.

ll Pundit Hot Keys

| Action Key Reference
IS{tg 131 list of all documents on the CD- CTRL+B Page 36
Copy selected text to the Windows
Launch a document using the
associated Windows application CTRLHL Page 32 |
Print the current document, selected
pages, or the Search Results list CTRL+P Page 33 ‘

|| Print a document’s image CTRL+P Page 23

n See a Quick Help reference CTRL+Q Page 36

[| See previous search information CTRL+S Page 35

I See the contents of the search index CTRL+V Page 35

“ Invoke context-sensitive help F1 Page 43

Il Reopen the Enter a Search window F2 Page 35

|1 g'ioz:/:n t;)nihe previous hit in a Ps Page 37
Move to the next hit in a document Fé Page 37
Open the previous document in the
Search Results list F7 Page 38
Open the next document in the
Search Results list F8 Page 38
Open the image associated with the

H current document F9 Page 21

e —— e —
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INDEX

Arithmetic Operators .
Boolean Operators
AND .
NOT .
OR .
Proximity
Within .
Browse
All Documents on CD-ROM .
Images of Current Document .
Hits in Document
Search List .
Previous Page (Image Vlewer)
Cascade (Window)
Close
Image . . .
Picture
Conventions Used in ThlS Gulde
Copy . .
Document Set Info
Edit . . . . .
Effects, Image .
Invert .
Enter a Search
Return to .
Exit
File
File Menu—Image Viewer.
File Menu—Pundit .
Find . . .
Fit Image . . .
Fuzzy Searches .
Help
About Pundit .
Contents .
How to Use .

.15

.12
.12
.12
.14
.14

.36
.26
.37
.17
.21
.43

.24
.28
.34
.31
.34
.25
.25
9 11 16

.35
.34

.23
.29
.35
.24
16 42

.44
.43
.44

51



INDEX

QuickBelp . < & ¢ 2 5 % % 5.6 5 & & 5 5 8 8 8 5 @ 36
SearchforHelpOn. . . . . . . . . . . . . .. .. 43
UsingHelp . . . « ¢ 4« s s v v & 3 % 5 5 % & 5 44
Hit
Defined . . . . . . . . . . . ... ... .... 17
NestiPrevions . - « : « 4 oo wmw s ¥ & 5 5 § % % % 37
HOEROYS o v s 6 ¥ 66 5 UREFR-E § 2 565 5 B 50
ImageViewer . . . . . . . . . . . .. ... .. 21-28
Installation of Pundit (System Requirements, Files Loaded) . . 3
IV o v o s & % & & 5 @i w RN BB ¥ 9 84 WG 25
Keyboard Equivalents . . . . . . . . . . . . . . 45, 47, 49
T Yl L E Y 32
MainWindow . . . . . . . . . . ... ... .... 29
Newldex. . « « ¢ v v« » ¢ 950 @ % ¢ 8 5 & &« 5 & 29
Next
Document’ « .« « ¢ s s e wmww & ¥ ¥ ¥ ¢ 4 & @ 38
Hit 2 526 55 8538 286 5% 5§ 8 5 5 8 5 0 37
PR o ooom o on B oo o o m om o eae W e w0 g B 26
MIOSH . o & ¢ ¢ v 4 &« s s wwa & & ¥ 8 5 & 5 % % % 1
o 6 - S T E R R Y 2,6
Options . . . . . . . . v e e e e e e e e e e e 38
PICOIBE. v v o & 5 & % 5 oo ws e R M OB W R N & N0 5 W 27
Previous
Documeit « « 5 s s 5 5 8 5 6 % & v & 4 4 5 & @& 38
HIE & 55 68 6 6 8 B B B8 B 3 4 5 28 6 & 37
PORE s Bof 5% B m e B B R 5E 28 Pl 26
51 R T T T L R R Y 33
IORBRE .. o v v 5 o 5 5 s s N s s ow m s 23
PrmtSetiy - o ¢+ ¢ o 5 s s wmww s 5.5 5 a4 % 4 @ a 33
IBAEE... .. ... - = =2 2 e Cum B8 & 8§ & B3 5 5 535 23
ProgressiveSearches . . . « v = v v « &« o & = & 15, 42
Pundit
AboutPundit . . . . . . . . . . . . ... .. L. 6
Pilesloaded . : « o 5« s 9 05 @ « 5 5 5 & 5 %5 S
HotEKeve: ¢ ; : i 5 s 5,9 % w € & % & 8 5 § 3% 50
MERINNE. . . » 5 2.0 &/ Gmsw i 5 on 8 & 5 & 5 g0k 3
DURETOWE & oo v 6 & 5 % o 5 3k ow dmeom w8 % om 9
Usingthe Keyboard . . . . . . . . . . . . . 45,47, 49
ek Help . .. - - d d AR EEE R E FEE e 36
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Quorum Operator .

Reset Image .
Results
Format

Hits in Document

Search . . .
Rotate
Save

As ASCII

Document/Portions

Preferences .

Search Results Llst

Search

Enter a Search .

Fuzzy

Multiple 'Dx.scs .

Progressive .

Word . . .
Search History .
Search Index .
Search String
Select New Index .
Sort

Direction .

Key .
ToolBars

Image Viewer .

Search Results
Text Viewer
View
Image .
Pictures .
Text. .
Vocabulary
Wild Cards

Window (Cascade) .

Word Search .
Zoom

. 11-16
. 16, 42

.29
16 42
.36
.35
11 35
. .12
.29

. .40
.40

.22
.18
.20

10, 21
.27
10 19
11,35
.13
.43
.36
.24
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